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Preface

Scope
This manual describes how to install and operate the GDC TEAM 5506/5516 software applica
The information contained in this manual has been carefully checked and is believed to be e
reliable. However, as General DataComm improves the reliability, function, and design of th
products, it is possible that information presented herein may not be current. 

For the latest information on any GDC product, refer to the General DataComm website at 
http://www.gdc.com or contact your GDC Sales Representative.

General DataComm, Inc.
Technical Publications Department
6 Rubber Avenue
Naugatuck, Connecticut, USA 06770
Tel:   1 203 729-0271

Using This Manual

The online (electronic) version of this manual uses active areas which allow you to navigate
specific sections of the manual by clicking on  blue underlined text. The content in this manual is
divided into the following chapters: 

Chapter 1, Introduction

Chapter 2, Operations

Chapter 3, Configuration

Chapter 4, Maintenance & Diagnostics
076R168-V400 TEAM 5506/5516 Version 4.0.0 v
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Service Support and Training
VITAL Network Services is a leading single-source, data communications organization that 
provides network service and support for General DataComm customers throughout the wo
VITAL Network Services can support and train in the installation, management and mainten
of your GDC equipment. Training courses are offered at centers in the US, UK, France, Sing
and Mexico, as well as customers’ sites.

For more information on VITAL Network Services or for technical support assistance, conta
VITAL Network Services at:

VITAL Network Services World Headquarters
6 Rubber Avenue Telephones: Faxes:
Naugatuck, Connecticut 06770 USA 1 800 243 1030 1 203 723 5012

1 888 248 4825 1 203 729 7611
http//www.vitalnetsvc.com 1 203 729 2461

VITAL Network Services Regional Sales and Service Offices:

North American Region Office
6 Rubber Avenue
Naugatuck, Connecticut 06770 USA
Telephones: 1 800 243 1030

1 888 248 4825
1 203 729 2461
1 800 361 2552 (French Canadian)

Training: 1 203 729 2461
Faxes: 1 203 723 5012

1 203 729 7611

Central America, Latin America
VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico D.F., Mexico

Telephone: 52 5 645 2238
Training: 52 5 645 2238
Fax: 52 5 645 5976

Europe, Middle East, Africa
VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF UK

Telephone: 44 1189 657200
Training: 44 1189 657240
Fax: 44 1189 657279

Asia Pacific
VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore 238880

Telephone: 65 735 2123
Training: 65 735 2123
Fax: 65 735 6889
vi TEAM 5506/5516 Version 4.0.0 076R168-V400
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Chapter 1:  Introduction

Introduction to TEAM 5506/5516
This manual describes how to operate TEAM 5506/5516 software applications for HP Open
These applications are used to configure and control SpectraComm 5506 OCU-DP  and 
SpectraComm 5516 DS0-DP operations. Throughout this document, all information relates t
devices except where noted. For the individual Installation & Operation manuals provided for
product refer to Related Publications. in the front of this document. A working knowledge of HP
OpenView and data port functioning is assumed.

Theory of Operation

The TEAM 5506/5516 Unix application is a collection of integrated applications for the HP 
OpenView Network Management Platform. TEAM employs Simple Network Management 
Protocol (SNMP) to control SC 5506 or SC 5516 units installed in a GDC SpectraComm 5000
system. TEAM 5506/5516 applications provides application windows and a Front Panel displ
configuring the units, diagnosing the units via loopback tests, and maintaining the firmware s
in the units.

All of the TEAM Controller applications use the HP OpenView APIs (Application Programme
Interfaces) to integrate with HP OpenView Windows and other network management applica
Menu items are accessed via pulldown menus from the appropriate HP OpenView submap o
the Front Panel drop-down menu. The TEAM Controller GUI screens meet HP OpenView pre
partner requirements. Refer to OpenView documentation for more information.
076R168-V400 TEAM 5506/5516 Version 4.0.0 1-1
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TEAM Management of the SC 5000 System

TEAM 5506/5516 applications manage the SpectraComm 5000 shelf system which consists
three types of hardware components: the dataport devices (SC 5506 OCU-DPs or SC 5516
DPs, a Line Terminating Unit (SC 5001 T1 LTU), and a SpectraComm Manager Card (SCM
future release of TEAM will support the SC 5002 E1 LTU. These TEAM-managed shelf 
components are described below and in Figure 1-1.

SC 5506 / SC 5516 Dataport Cards

The SpectraComm 5506 High Density OCU-DP card is a SS7 Signal Transfer point (STP) ne
access device designed for installation in a SpectraComm shelf located at a SS7 point of pre
A single SpectraComm shelf with a SpectraComm Manager Card may hold up to three SC 
LTUs, each interfacing with up to four SC 5506 units. Up to four SC 5506 cards in the shelf 
as a channel bank for one SC 5001 LTU, splitting one T1 line into as many as 24 DS0 chan

The SpectraComm 5516 High Density DS0-DP card is also a SS7 Signal Transfer point (ST
network access device designed for installation in a SpectraComm shelf located at a SS7 p
presence. A single SpectraComm shelf with a SpectraComm Manager Card may hold up to
SC 5001 LTUs, each interfacing with up to four SC 5516 units. Up to four SC 5516 cards in
shelf serve as a channel bank for one SC 5001 LTU, splitting one T1 line into as many as 2
channels. 

With either the SC 5506 or the SC 5516, transmission data occupies 64 kb/s timeslots on one
4.096 Mb/s SpectraComm backplane data highways. This data is converted by the SC 5506
DS-0 bipolar AMI 56/64 kb/s signal for connection the SS7 STP.  The SC 5516 converts this
to a DS-0A bipolar NRZ AMI 56/64 kb/s signal for connection to the SS7 STP.  Since SC 55
units or SC 5516 units would be co-located with the SS7 STP, line protection for outdoor loo
connections is not required.

SpectraComm Manager Card

TEAM 5506/5516 applications operate in conjunction with a SpectraComm Manager (SCM)
to provide comprehensive network management capabilities using the Simple Network 
Management Protocol (SNMP). The SCM acts as the SNMP proxy agent through which TE
management applications communicate with SpectraComm 5000 shelf components and oth
compatible equipment.

All management communications are directed to the SCM card Internet Protocol (IP) addres
SCM card relays commands and responses between management applications and hardwa
components, using a slot addressing scheme to communicate over the SpectraComm shelf
backplane with the other components. The SCM is transparent to the applications, which ope
though they were communicating directly with the hardware units. The SCM card is manage
the TEAM Core application, which is also responsible for the discovery and mapping functio
TEAM Applications within the HP OpenView framework.
1-2 TEAM 5506/5516 Version 4.0.0 076R168-V400
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SC 5001 (LTU) 

The SpectraComm 5001 LTU performs network interface and channel grooming functions f
group of dataport units (up to four SC 5506 OCU-DPs or up to four SC 5516 DS0-DPs). Eac
SC 5001 LTU connects to a T1 line and transmits the combined data traffic of its group of da
units to a Telco switching site. The T1 line provides 24 channels for that purpose. Telco swit
equipment routes the channels to their individual remote destinations. In this way a single T
connection between an SC 5000 site and a Telco switching site can support up to 24 conne
with remote sites. One SC 5506 OCU-DP unit employs six channels (timeslots); one SC 551
DP unit employs six channels (DS0s) configured in three consecutive pairs. 

In a future release, the SC 5000 system will support a SpectraComm 5002 LTU. This permi
connection to the E1 line which provides 30 channels for data and two DS0s for network sign
and framing. The SC 5002 would perform network interface and channel grooming function f
to five dataport units (SC 5506 OCU-DPs or SC 5516 DS0-DPs).  

Note For more information on these SpectraComm product cards, refer to the GDC Technical Publications
Release Notes that accompany these products.

 

Figure 1-1 Managing the SC 5000 System with TEAM (Shown with SC 5516 DS0-DP)
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The TEAM 5506/5516 Applications
All TEAM applications can be accessed from either of two user interfaces. Table 1-1 lists the 
applications as they appear in the HPOV menu bar interface. Table 1-2 lists the applications as they
appear in each managed unit’s Front Panel Select  button.

Access from the HPOV Shelf Map Window Menu

1. Select the network element you intend to work with (SC 5506 or SC 5516) by clicking on
its icon in the shelf map.

2. The TEAM 5506/5516 application functions are arranged on the menu bar at the top of 
HPOV Map window as shown in  Table 1-1.

3. From the Map window, open the TEAM 5506/5516 application you intend to use.

4. To select multiple icons in a map window, click and drag a box around the desired icons
click on icons individually while holding down the Control and Shift keys. Up to ten icons
the same device type can be selected at a time. 

Table 1-1 TEAM Applications from the HPOV Menus

Menu Selection
TEAM 5506/5516 
Applications

Description

Performance Front Panel Shows the status of the unit’s LEDs and provides an interface 
to the rest of the applications via a Select button menu.

Alarm Detail... Displays alarm information in a read-only window.
(SC 5506 only)

Configuration Configuration... Provides read/write windows for setting unit configuration 
parameters. 

Maintenance... Performs device reset functions. 

Fault Diagnose Accesses the Diagnose application which allows you to 
command the test functions of the unit. 

Misc Information... Displays application name and revision level, similar to 
clicking on the GDC logo in the Front Panel display.

Front Panel Poll Rate... Sets a default polling interval to be in effect each time the 
Front panel display is opened. 

Note Pad Opens a shell tool (editor, mail tool, etc.) for keeping records 
on the system.

Note The Note Pad  application is selected only from the Misc menu and not available at the Front Panel m

Note Your HPOV menu may show additional selections depending on other supported applications.
1-4 TEAM 5506/5516 Version 4.0.0 076R168-V400
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Access from the Front Panel Display

The Front Panel application summarizes the real-time status of the SC 5506 or SC 5516 by
displaying the states of the LED indicators on the unit. A Select  button on the Front Panel display
accesses the application menus and their functions.

1. Select the network element you intend to work with (SC 5506 or SC 5516) by double-clic
its icon in the shelf map. This immediately launches the Front Panel Application for that 
element and displays the Front Panel for that unit appears.

2. In the Front Panel display, click the Select  button to access the application menu. Table 1-2 
describes the available applications. 

Table 1-2 Team Applications from the Front Panel

Menu Selection Applications Description

Performance Front Panel display Shows the status of the LEDs.
Provides an interface to the rest of the applications.

Alarms Displays detailed read-only information about alarm state changes.
(SC 5506 only)

Configuration Configure Provides read/write windows for viewing and configuring a 
selected unit.

Maintenance Performs device reset functions.

Fault Diagnose Runs diagnostic tests on a selected SC 5506 or SC 5516.

Note You can access the Information function by clicking the GDC logo icon on the Front Panel display. N
that the Front Panel Poll Rate, Note Pad and Alarm Severity applications are only available through
Map Window menu bar. 
076R168-V400 TEAM 5506/5516 Version 4.0.0 1-5
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Window Features in TEAM Applications

Table 1-3 describes features that are common to all TEAM application windows.

Table 1-3 Typical Application Window Features

Window Feature Description

Title bar Identifies the specific TEAM application running in the window, i.e., 
Configuration, Diagnostics, Alarms Reported, etc. 

Minimize button Available only when TEAM software is running on a SUN workstation in an 
OpenWindows environment.
Click to minimize window to an icon. Double-click icon to restore the window. 
Located in the Title Bar of each application window.

Menu bars Provides pulldown menus for common utilities, such as File->Exit and Help. Icon 
menus provide application-specific options.

Name field Indentifies the shelf and slot location of the card of interest, followed by the 
card’s slot: line: drop notation.

Command buttons Click command buttons to execute a command instantly, such as Reset, Cancel 
or OK. 

Pulldown lists Pulldown and scroll to select options for equipment types, function parameters or 
operation controls for the application.

Glyphs Click grayed-out diamond glyphs to select options, click again to deselect.

Entry Fields Click to activate entry field for user-defined data, such as IP addresses, shelf 
names, system information.

Multiple Select buttons Click to globally select and deselect frequently grouped options.

Data Display Read-only information configured by the user or determined by the system.

Note Grayed-out selections represent options that are disabled or not available with the current configura

Data
Display

Selection
Gylphs

PulldownCommand 

Minimize
Button

ListsButtons

Menu
Title Bar

Bar

Multiple
Select
Buttons

Messages

Command 
Buttons

Pulldown
Lists
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Chapter 2: Operations

Overview

This chapter describes the operation of the TEAM 5506/5516 applications as they are group
under the Performance menu, Fault menu, and Misc(ellaneous) menu. Note that these TEA
applications operate the same for both the SC 5506 OCU-DP and the SC 5516 DS0-DP, ex
where noted.

Note TEAM 5506/5516 Configuration applications are described in Chapter 3.
TEAM 5506/5516 Diagnostics and TEAM 5506/5516 Maintenance applications are described in Cha

TEAM 5506/5516 Performance Applications

The Performance menu launches the following applications:

• Front Panel application displays a representation of the dataport unit’s front panel which s
the status of LEDs and provides access to the rest of the TEAM applications

• Alarms application displays alarm information in a read-only window (SC 5506 units only

Front Panel Application

The Front Panel application is a graphical interface of a selected SC 5506 or SC 5516’s Front
with associated menu items. This application launched from the HPOV Map (shelf sub-map
window, or by double-clicking on the slot icon of the desired unit. 

Each time the Front Panel display is opened, its initial polling rate is determined by the Front
Poll Rate selection of the HPOV map window Misc menu. The application polls the unit to kee
states of the LEDs in the Front Panel display current. The time of the most recent poll appear
bottom of the Front Panel display, to the left of the Help button.

The Front Panel Select menu provides two Poll selections which determine when the 
application collects new information from the unit to update the Front Panel window: 

• Demand Poll
Selecting Demand Poll causes an immediate update of the Front Panel display.

• Auto Poll
When Auto Poll is enabled the last poll time appears in white on the Front Panel dis
When disabled, the last poll time appears yellow 

Note Table 2-1 describes in detail the Front Panel application. Front Panel Poll Rates are discussed in detail
in this chapter.
076R168-V400 TEAM 5506/5516 Version 4.0.0 2-1
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Front Panel Display and Menus

The Front Panel display reflect the states of the actual LED indicators on the physical units 
(SC 5506 or SC 5516). Both types of dataports have the same appearance; functional differ
are noted in Table 2-1, below.  

 

Table 2-1 The Front Panel Display (Shown SC 5516 DS0-DP)

Front Panel Displays LEDs/Menus Description

ON Steady GREEN LED indicates the unit is getting shelf 
power.

INS Steady GREEN LED indicates the unit has been put into 
service by the SCM.

Channels 1 - 6 Steady GREEN LED indicates which timeslot 
(SC 5506) or which DS-0A (SC 5516) has been selected 
for external testing via the Front Panel LVL test jacks. 

TM Steady RED LED indicates the selected channel is being 
tested with intrusive TX data.

ALM Steady RED LED indicates an alarm condition 
exists on the selected channel. 
(SC 5506 only)

Select Menu Opens menu list for selecting other TEAM applications:

Alarm Detail Displays alarm information in a read-only window.
(SC 5506 only)

Configuration Provides read/write windows for configuring unit options.

Maintenance Provides read/write windows for performing unit 
maintenance

Diagnostics Accesses the Diagnose application for commanding the 
test functions of the unit and viewing test results.

Demand Poll Causes an immediate update of the LED states.

Auto Poll Updates the LED states at user-selected polling intervals: 
15, 30, or 60 seconds.

Disable
(Polling)

Display a static snapshot of the LED states as they were 
at the last poll (when window was first launched or from 
the most recent Demand Poll.)

Exit Dismisses the Front Panel

Message Area Displays messages which describe application activity 
and unit interactions, i.e., time, responding, etc.

GDC Logo Clicking the GDC icon displays the application name and 
the revision level.
2-2 TEAM 5506/5516 Version 4.0.0 076R168-V400
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 Alarm Detail Application

The Alarms application is accessed from the HPOV menu bar Performance menu or from the
Panel’s Select menu. This application opens an Alarm Detail window for the selected SC 550
displaying the status of all reporting LOS alarms configured by the user. Once the desired a
are configured at the Alarms Reported screen, the Alarms application retrieves the most cu
alarms from the selected unit at user-defined polling intervals. Alarms Detail window selection
described in Table 2-2.

Note The TEAM Alarms application is available for SC 5506 OCU-DP units only.  

Note To set polling intervals, refer to the Front Panel Poll Rate application, later in this chapter.
To configure the unit to report LOS alarms for one or more loops, refer to Chapter 3, Configuration: Al
Reported window. 

Table 2-2 The Alarm Detail Application

Alarm Detail Window Selection Description

Loss of 
Signal

A RED LED indicates an absence of 
network signal on any channel (1-6) 
configured for alarm reporting.
Absence of signal for a time equivalent 
to 175 bits (± 75) is considered no 
signal. 

File -> Exit This menu command closes the 
application window.
076R168-V400 TEAM 5506/5516 Version 4.0.0 2-3
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TEAM Miscellaneous Applications

Front Panel Poll Rate Application

Launch the Front Panel Poll Rate window from the HPOV shelf map Misc menu. The setting
select in this window determines the initial polling rate for Front Panel displays each time the
opened.

The rate selection is a global function. It selects initial polling rate for all front panel displays lin
to a TEAM Core application, regardless of which individual application you access it from. T
precise polling frequency that results from a setting of Slow, Normal, or Fast depends on a n
of factors. The higher the rate, the more communication and processor capacity is devoted 
maintaining the display.

Setting a Global Poll Rate

1. Set the a global polling rate for all front panels 
by clicking an appropriate diamond:

• Slow

• Normal

• Fast

• Demand Poll Only

• From the Front Panel Poll Rate File menu, 
select Save to File to store the 
setting for all front panel displays.

2. From the File menu select Exit to dismiss the 
window.

Setting an Individual Poll Rate

To change the polling rate for an individual front panel, access the Front Panel application fo
unit and use the Select menu to set Auto Poll. The change is only valid for the duration of a s
and is not saved when the Front Panel display for that unit is closed.

Note Pad Application

Launch the Note Pad application from the shelf submap Misc menu. The application opens 
editor which can be used for keeping records on the system. 

TEAM Information Application

Launch the TEAM 5506/5516 Information window from the HPOV shelf map Misc menu or b
double-clicking on the GDC logo in the Front Panel display. This application displays one read
window that contains the name of the application, software revision level information, and 
copyright information. The File menu in the menu bar provides the Exit command which closes 
the application window.
2-4 TEAM 5506/5516 Version 4.0.0 076R168-V400
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Other TEAM 5506/5516 Applications

TEAM 5506/5516 Configuration Applications

The TEAM 5506/5516 Configuration Application launches three smaller application windows 
to configure SC 5506 or SC 5516 operation. These configuration windows are launched from
shelf map Configuration Menu or from the Front Panel Select button menu:

• The Alarms Reported window is used to select alarms that will be reported and monitore
the Alarm Details application (SC 5506 OCU-DP units only).

• The Unit Options window is used to configure parameters for each loop.

• The Maintenance Options window allows the user to perform a soft reset, or perform a r
using factory defaults.  

Note Detailed descriptions and procedures for the Configuration Application are provided in Chapter 3.

TEAM 5506/5516 Diagnostics Application

The TEAM 5506/5516 Diagnostics Application launched from the shelf map Fault Menu or f
the Front Panel Select button menu. This application is used to select diagnostic test parame
start and stop tests, and display test data in the current diagnostics session.

Note Detailed descriptions and procedures for the Diagnostics Application are provided in Chapter 4.
076R168-V400 TEAM 5506/5516 Version 4.0.0 2-5
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Chapter 3: Configuration

Configuration Application Overview

The TEAM 5506/5516 Configuration application is launched from the shelf map Configuratio
menu or the Front Panel Select button menu. When the application is launched, a Main 
Configuration window appears, providing read-only unit identification information, a status 
message area, a File menu for managing configuration templates and a Navigate Menu. 

The Navigate Menu provides one or two additional configuration windows which control netw
element operation: 

• Alarms Reported window (SC 5506 OCU-DP only)

• Unit Options window

Using Configuration Templates

A specific unit’s configuration is determined by the settings of several configuration options 
parameters. Configuration templates allow the user to acquire the configuration settings from
without interrupting the unit’s operation or changing its configuration.  Similarly, a configurat
can be acquired, modified and saved as a variation, leaving the unit’s current configuration 
unchanged.

Once a configuration has been acquired and modified for a particular functionality, it can be s
as a template on the workstation that runs the TEAM 5506/5516 application. Any number of
templates can be stored for retrieval when particular configuration settings are needed. 

The three template functions (Save , Load and Compare ) are accessed from theMain 
Configuration window File menu. A Quick Configuration procedure for loading a previously sto
template is provided below. To acquire and save configuration templates, refer to the more d
Basic Configuration procedure that follows. 

Quick Configuration from a Stored Template

1. Select Load Template  from the File menu and select the template from the resulting 
dialog window.  The application retrieves the configuration settings of the selected templ

2. Select Save to Unit  from the File menu.  The application makes the template 
configuration settings the current operating configuration for the unit.

3. Select Compare from the File menu to compare the screen’s configuration data to a spec
template.
076R168-V400 TEAM 5506/5516 Version 4.0.0 3-1
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Configuration Basics
This section provides the basic steps for configuring the unit. The next sections describe ea
configuration window menu and its selectable options.

1. Access the main Configuration window, either from the submap configuration or from the
Front Panel configuration display. When the main window opens, the application reads t
current main configuration from the unit. 

2. If you want to make changes to the configuration based on a template, select Load  
Template  from the File menu and then select a template from the resulting list before 
proceeding.

3. Click on the Navigate  button to display a menu of the configuration windows and then 
select the first one in which you intend to make changes.

4. Click on the desired input fields to open a list of available values for each option, then cli
the desired value. 

5. You can discard changes made in a configuration window and return all its fields to their s
values in two ways:

• Click on the Reset  button to discard changes while keeping the window open

• Click on the Cancel  button to discard changes and close the window. 

6. Close a configuration window without losing changes by clicking on either the OK button or 
the push-pin glyph in the upper left corner of the window.

7. Continue to select other configuration windows to make additional changes. Refer to the
following sections of this chapter for descriptions of each configuration window menu an
selectable options.

8. When you have accessed all the configuration windows for changes, use the main 
configuration window File menu to save all changes in two ways:

• Select Save to Unit  to send the changes to the unit as the new current configura
This activates the changes instantly in the unit.

• Select Save to Template  to save the changes to a template on the workstation. T
allows the unit to continue operation without changing any of its configuration setti

A list of existing templates appears with a field for entering a new template name. S
an existing template to overwrite it with the new configuration, or enter a new nam
create a new template. A stored template can be loaded to a unit or retrieved and ch

Note The File menu Refresh selection also reads the current configuration from the unit. 
If you select Refresh  during the configuration process, any configuration changes made in any co
figuration window will be lost unless thay have been saved to a template or to the unit. 

Note You can keep multiple configuration subwindows open and move between them with a mouse click
Main Configuration window remains on-screen throughout the configuration process. 

Note When you change an option, the application displays the option name and the new value in white tex
option text will turn black when the changes are stored to the unit or template, or discarded.
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Configuration Application Windows
The Main Configuration window is launched from HPOV menu -> Configuration . 
Table 3-1 describes the application window layout and read-only information. 
Table 3-2 describes the application menu selections.

 

Table 3-1 Main Configuration Screen

Note The SC 5506 or SC 5516 unit can be switched from the current operating version of firmware to a sto
version of firmware. This function is performed via the TEAM Core Firmware Download Application. 
Refer to the TEAM Core documentation and TEAM Core Release Notes for detailed procedures.

Display / Menu Selction Description

Name Read-only field that displays the shelf identification and the slot 
number of the selected unit.

Slot State Displays the state of the slot occupied by the unit: Active or Inactive.

Operational State Displays the operational state of the unit: Up or Down.

Serial Number Displays the serial number of the unit.

Active Firmware Revision Shows version of the currently operating (active) firmware on the unit.

Standby Firmware Revision Shows version of the non-operating firmware on the unit. This is 
typically the previously released version of the firmware.

MIB Version Displays the MIB version (Management Information Base) for the unit.

Message Area Displays application activity and unit interaction messages in the 
lower left corner of the window, such as:
Reading , Writing , Saving to Template , etc.

Menu bar

Read-only
System 

Title bar

Messages

Information
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Configuration Menu Bar

The menu bar provides a File and Navigate menu for configuring the selected unit. Use the 
Navigate  menu to select the individual configuration windows for change. Use the File  menu 
for storage and retrieval of previously stored templates of configuration settings.Table 3-2 describes 
the menu selections.

Note If the Configuration Application Main Menu is exited while pending (unsaved) edits exist on any of th
subordinate configuration screens, the following prompt will appear: 
            Pending edits exist, do you want to save or 
             exit without saving the changes?

Table 3-2 Configuration Menu Selections 

Menu Buttons Selections Description

File Refresh All options are read from the unit and outstanding edits are 
lost.

Save to Unit All outstanding edits are sent to the unit.

Load Template Allows the selection of an existing SC 5506 or SC 5516 
template to be applied as edits to the current application. 
Your next File-->Save to Unit implements the template 
changes.

Save to Template Configuration data is saved as a specific template.

Compare to 
Template

You can select an existing SC 5506 or SC 5516 template to 
be compared with the screen display.

Exit Terminates application with outstanding edits discarded first.

Navigate Unit Options... Displays the Unit Options window.

Alarms Reported... Displays the Alarms Reported window.
(Available for SC 5506 untis only)

All Screens... Displays both the Unit Options and the Alarms Reported 
windows of the Configuration application.
(Available for SC 5506 units only)
3-4 TEAM 5506/5516 Version 4.0.0 076R168-V400
Operation Manual Issue 1



Configuration Configuration Application Windows
Unit Options Window

The Unit Options window is launched from the Main Configuration  Navigate menu. 
Table 3-3 describes the unit and channel option settings. .

Composite Clock Guidelines

• Only one card in a shelf can be selected as Primary composite clock provider.

• Only one card in a shelf can be selected as Secondary composite clock provider.

• Any card not selected as Primary or Secondary must be selected as Shelf .

Table 3-3 Unit Options Window (Shown: SC 5516)

Selections Description

Composite Clock Provider Selects the composite clock timing: Primary, Secondary or Shelf.
(Selectable for SC 5516 DS0-DP units only)

Channel Enable Enables or Disables the specific channel (1 - 6).

Latching Loopback Enables or Disables Latching Loopback for the specific channel (1 - 6).
(Selectable for 54Kbps, forced Disabled for 64Kbps)

Zero Code Suppression Enables or Disables zero code suppression for the specific lchannel (1 - 6).
(Selectable for SC 5506 OCU-DP units only)

Data Rate Select the customer data rate at 56Kbps or 64 Kbps

OK Closes the window, similar to a pin pull. Edits are maintained but not saved.

Reset Undoes pending edits since the last  “File --> Save to Unit” operation.

Cancel Undoes pending edits since the last  “File --> Save to Unit” operation,
and then closes the window.
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Alarms Reported Options 

The Alarms Reported window appears when you select Navigate-> Alarms  Reported  
from the Main Configuration window menu. This screen allows you to set which alarms are 
reported at the Alarms Detail Application. Table 3-4 describes the window selections.  

Table 3-4 Alarms Reported Window

Selection Description

Report All Globally selects all channels (1 - 6) for reporting the LOS alarms.

Report None Globally de-selects all channels (1 - 6) so that no LOS alarms are 
reported. 

Loss of Signal The unit detects a loss of signal on the selected channel. Loss of signal 
for a time equivalent to 175 bits (± 75) is considered no signal. 
Click a check diamond to enable the reporting of the LOS alarm for that 
channel.

OK Closes the window, similar to a pin pull. 
Edits are maintained but not saved.

Reset Undoes pending edits since the last  “File --> Save to Unit” operation

Cancel Undoes pending edits since the last  “File --> Save to Unit” operation
and then closes the window.
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Chapter 4: Maintenance &
Diagnostics

Maintenance Options

The TEAM 5506/5516 Maintenance application is launched from the HPOV Map Configurat
Menu or from the Front Panel Select menu. The application provides a Maintenance window (Table 
4-1) that displays a read-only Name field and provides unit reset options.

Maintenance Procedures

1. To perform on the unit a Soft Reset or a Reset to Factory Defaults,  click the appropriate
command button. A warning appears as follows:

Resetting to factory defaults will disrupt communications to 
the unit. Do you want to continue?

2. At the confirmation window, click Cancel to resume operation with the existing unit 
options. Otherwise, click OK to reset the unit for operation with factory default settings. 

Table 4-1 TEAM Maintenance Reset Options (Shown: SC 5516 DS0-DP)

Maintenance Window Field/Option Description

Name Field Displays shelf and slot identification for the 
SC 5506 or SC 5516 dataport unit.

Reset to Factory 
Defaults

The unit performs a reset and then 
configures itself to the factory default 
settings.
In order to resume operation, the user must 
repeat the highway configuration 
procedures and may need to change other 
configuration options. 

Perform Soft 
Reset

The unit performs a board reset and then  
resumes operation using its existing 
configuration. 
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TEAM Diagnostics Application

The Diagnostics application is launched from the HPOV menu bar Fault menu or from the F
Panel tool bar. This application tests a SC 5506/SC 5516 unit or the network and displays r

Diagnostics Overview

The Diagnostics application provides read-only data, test options, command buttons and a d
which reflects the diagnostic data path for the selected test. Arrows on the diagram indicate c
data paths and change to show loopback paths associated with each test. Figure 4-1 and Table 4-2 
describe each component of the the Diagnostics window. The Diagnostics procedure follow

Figure 4-1 The Diagnostics Window (Shown: SC 5516 DS0-DP)

Note Multiple units can be selected for simultaneous Diagnostic testing; however for any single instance o
Diagnostics Application, only one channel can be tested at a time. 

Note Diagnostic test selections will appear grayed-out when the selection is not supported by the unit or in
combination with other test options.

Note All TEAM 5506/5516 Diagnostics require that the unit is receiving shelf timing and has its channels ass
to DS0 numbers on a shelf backplane data highway. 

Test Options

Command 
Buttons

Data Path 
Display

Test Status  
and Results

Application Title Field

Messages

Read-only Unit ID

Menu Bar
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Table 4-2 Test Selections

Selection Option Available on: Description

Channel 
Select

Channel 1 - 6 SC 5506
SC 5516

Selects a channel (1 - 6) for diagnostic testing.

Test Options Line Loop SC 5506
SC 5516

The unit activates a loopback test where data is 
looped back towards the DS-0A (SC 5516) or 
towards the DS0 (SC 5506). The data is checked 
by external test equipment.

Channel Loop SC 5506
SC 5516

The unit activates a loopback towards the DS-1. 
The data is checked by external test equipment.

511 Pattern SC 5506 only The unit activates an internal 511 test pattern 
generator/checker.

2047 Pattern SC 5506 only The unit activates an internal 2047 test pattern 
generator/checker.

Test Blocks SC 5506 only Selects the number of data blocks sent during the 
test; applies only to tests using a test pattern. 

Test Command 
Buttons

Start Test SC 5506
SC 5516

Starts the selected test.

Stop Test SC 5506
SC 5516

Stops the selected test.

Test Status & 
Results

Test Duration SC 5506 only Read-only display of the time displays how long the 
511 or 2047 pattern test will take to complete.

Time 
Remaining

SC 5506 only A meter display of the time remaining in the current 
511 or 2047 pattern test, in percent.

Test Results SC 5506
SC 5516

Depending on the unit type and test selected,  
displays test progress message or bit error results.

Messages Last Update SC 5506
SC 5516

Lower left side of window displays the time of the 
last update

Status SC 5506
SC 5516

Lower right side of window displays intermittent 
messages which describe the application activity 
and unit interaction  (i.e. waiting for response from 
unit; initialization messages; communication errors)
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Diagnostics Menus and Read-only Fields

• The File menu provides the Exit command for closing the application window. The 
Diagnostics application polls continuously until the Exit command is made.

• The Navigate menu provides a History  option which displays a read-only screen of test 
results from the current session. Table 4-3 describes the Diagnostics History screen. 

• The read-only Name field displays the shelf identification and the slot number of the selec
unit.

Diagnostics Procedure

1. Click the check box for the test to be performed: Line Loop , Channel Loop , 511 or 
2047 . 

2. If desirable for SC 5506 units,  click on 511 or 2047 to use an internally generated test
pattern. Test patterns are not available for SC 5516 units or when a channel loopback te
selected. 

3. If an internally test pattern is selected,  set the desired number of Test Blocks 
to run during the test (1000 bits/block).

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the d
path employed by the test. 

• If you are using one of the internally generated test patterns, the Time Remaining 
field counts down from 100% to 0%. The Test Duration field displays how long 
the test will run until completed.

• When a internally generated test pattern is in use, the Test Results field appears 
as follows:

Running: [number of errors detected]

• When a line or channel loopback test is selected, the Test Results field can display 
various status messages, such as OK, Running , Stopped , etc.

5. To terminate any test, click the Stop Test button at any time. 

• Tests with internally generated test patterns will stop automatically when complete

• Line and channel loopback tests will run continuously and must be stopped with th 
Stop Test button. 
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 Diagnostics History 

The Diagnostics History screen, shown below, is accessed from the Diagnostics window 
Navigate  menu. This screen displays test data for all tests run during the current session,
including stopped tests. Table 4-3 describes the read-only test data fields. 

Table 4-3 Diagnostics History Window (Shown: SC 5516 DS0-DP)

Field Test Data Description

Name Displays the shelf identification and the slot number of the selected unit.

Start Time Displays the day, month, date and time the test was started.

Test Displays the type of test performed.

Channel Displays the channel selected for the test. 

Pattern Displays the internally generated test pattern selected: 511, 2047

Test Blocks Displays the number of test blocks sent in a 511 or 2047 pattern test.

Test Results Idle:  [#/#] Indicates a completed test with test pattern and displays the 
Bit/Block Errors.

OK Indicates a completed test without test pattern.

No Results for 
this test...

Indicates ??

Test Stopped Indicates a 511 or 2047 pattern test that was stopped before its 
completion time.

OK Button Closes the Diagnostics history window.

Note During an on-going diagnostic session the Diagnostics History window can be closed without loss o
data. If the Diagnostics application is exited, any Diagnostics History screen test data will be lost.
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